ArgoLink® User’s Manual

In this Manual you will learn:
B The communication utility in ArgoBuiler
B How to send files from ArgoLink to the target device

B How to received files from the target device to ArgoLink
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1. Introduction

The Purpose of ArgoLink is to download and upload the data from Portable Data
Collector (PDC). The files must be created by ArgoBuilder and the extended file

names ended in .abp, .cft (font file), .dat (index file).

Besides transferring data, ArgoLink features:
B Format the Hard Disk in PDC
Bm  Update the firmware

B Download the self-developing program.

Activate ArgoLink from ArgoBuilder by clicking on the ArgoLink icon on the

toolbar, or selecting it from menu tools> ArgoLink.

To activate ArgoLink from Windows, select ArgoLink from start > programs >

ArgoLink
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2. Communication Parameters

In order to transfer files between a Host PC and a PDC :

1. Connect the PDC’s RS-232 port to the PC’s serial communication port, power

on the PDC.
2. Start the ArgoLink application program.

3. Set ArgoLink communication parameter. Select setting under the Setup menu.

The Com-Port setting dialog box will appear.

COM Port Setting

Options
Paort:
Baud Rate: lm
Data Bits: l—_|
Parity: l—_|
Stop Bits: l—_|
Connect Cffline |

Set the parameters as follows :
Port : Select the com-port connected to the PDC. Click Port to set the com-port

properties.

Baud Rate : 115200

The dafault of ArgoLink is 115200.

Note : In order to carry out a successful communication session, the
communication parameters of the PDC and the Host PC must match each

other.

ArgoLink (V1.00) 2



ARGOX

Data Bits : 8
Parity : None
Stop Bits : 1

The important issue in these settings is that they must be identical to the setting
in the PDC. Otherwise, the host PC and PDC will not be able to understand each

other and communiation will fail.

4. At this stage, ArgoLink will have established communication with your PDC

and will display the PDC's file directory in a tree-like fashion.

ArgoLink provide two modes, Project Mode and Remote Mode, for downloading

files. Please refer to following chapters for more detailed.
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3. Remote Mode

The operation of Remote Mode is the same as common computer file operating.
The user needs only to point and click (keeping the button depressed) on the file
to be copied, drag the file to its destination, and then drop it by releasing the

mouse button.
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Remote Mode always displays a PC window on the left side, which shows all
drives and folders in the host PC. On the right side is a comparable window for

the PDC.

When this mode used, file must be put into correct directory. Otherwise, the

program will not be able to work successfully.
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Note:

Below are the file usages of ArgoBuiler:

ARGOX

Ext. file Stored o
Item ] Description
name directory
Program ABP D:\Program Main program in Project
When user collects and
confirms the collected data to
collector, the system will
Lookup file DAT D:\Lookup search the specified lookup
file for any matched string,
and replace it with the data
shown on the display.
SFT SFT is the system font and
Fonts D:\Fonts
CFT CFT is downloaded font.
The stored area of collected
Data DAT C:\Data

data in program
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4. Project Mode

Transferring files between the PC and PDC now becomes simple. When project
mode is chosen, all the data files bounded with ArgoBuilder will be downloaded
automatically. Project Mode can reduce the chance of wrong directory happen.

In addition, user can check Lookup file and data file quickly. They can modify

wrong link in ArgoBuilder if wrong directory happen.

Note: Project Mode can transfer 10 programs (or application) in one time. |If

more than 10 programs need to be transfer, then you need to do twice.

P Vaw Zemp Tool Help

&0 -
Project

Frogram
Remowve
oot |

Sample] abp
__'- l_
Lookup File:
Friod.dat

Data File:

[ et
[Pt bk
Out bt

=l

i aria L |
=) o voi K
Stahe Serd Recetve Sehbup

Fooul —_—

1. Add: Search project record file (.ini) produced by Argobuilder to load into PDC

2. Remove: Remove a loading project

3. About: Provides information about ArgoLink application program — such as

software version number

4. Status: Verify PDC firmware version and hard Disk status

5. Send: the process of transmitting files from the Host PC to PDC.

6. Receive: Transmitting files from PDC to a Host PC. <Carriage-Return> and
<Line-Feed> characters can be added, or delete the files in PDC after
completing loading.

7. Setup: COM Port Setting
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5. Menu Function

5.1 The File Menu
Add: (Project Mode Only): add project produced by ArgoBuilder to load into
PDC

Receive: Transmitting files from PDC to a Host PC
Exit: End ArgoLink

5.2 The View Menu
Project Mode: Switch to Project mode

Remote Mode: Switch to Remote mode

5.3 The Setup Menu
Select Connect Port: Choose Serial port (Com port) or USB

Setting: Set protocol of Com port or USB port

COM Port Setting

Options
Paort:

Baud Rate: lm
Data Bits: |—_|

Parity: l—_|
Stop Bits: ﬁ

Cc:nneu:tl Offline |

Receive Setup:
Add <Carriage-Return>: Add character <OxoD> while collecting data
Add <Line-Feed>: Add character <OxOA> while collecting data

Delete File: Delete the collected data after collecting
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Daemon setting:

Daemon Start: Open daemon function. ArgoLink will transmit data
automatically according to user defined time and specified
file.

Note: PT-10/12 must be connected to Host PC.

Setting: Setup the file receiving parameters of Daemon.
Save Path: specify saving location in Host PC
File 1 ~ File 10: specify complete path on the PT-10/12 including the
drive, directory and file name
Daemon Time: files auto receive time can be set in fixed interval or
certain time.
e )

Terminal File

Save Path |C:\Prugram Files\ARGOX\Argol

™ File 1

[~ File 2

™ File 3

|

|

|

I~ File 4 [
I~ File § [
|

|

|

|

|

™ File 6

[~ File 7

[” File 8

[” File 9

" File 10

Daemon Time

@« Detecting |10 sec.  ~|perinterval time
" When [~ =

r [ L% 10:46018 =
& [EF 102608 =
0K ‘ Cancel ‘

5.4 The Tool Menu
Format C: Format PT-10/12 Hard Disk C of PDC
Format D: Format PT-10/12 Hard Disk D of PDC
F/W Update: Update the PDC firmware

Cradle F/W Update: Update the cradle firmware.
Defrag Disk D: This option will defragment files on Disk D of PDC
Language Support: Download the menu other language resource to change

PDC system menu
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5.5 The Help Menu
Help Topic: Display help content.

About: The About command provides information about the ArgoLink

application program — such as software version number

Cradle F/W Version: this command provides information about Firmware

revision of cradle

6. Tool Bar

1. Project Mode Toolbar

o 444
= s -

[Z Create a new project to download

-; Receive a data file from terminal

== | Firmware update

-; Receive a data file from terminal

== | Firmware update
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7. Question and Answer

7.1 How to install USB driver
1. Generally, the drivers for USB devices are found automatically; however, in

Win98 > WIinME, you might need to re-install the drivers. If Windows does not
automatically detect the devices, use the "Add New Hardware" feature in the

control panel to find the USB devices.

Add New Hardware Wizard

Thiz wizard gearches for new drivers for;

USE Human Interface Device

& device driver iz a software program that makes a
hardware device work.

< Back

Cancel |

2. Choose first option = Next

Add Hew Hardware Wizard

Wwhhat do pou want Windows to do’?

& Search for the best driver for your device.
[Recormmended). :

= Dizplay a list of all the divers in a specific
lozation, o wou can select the diver you want.

< Back I Mest » I Cancel
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3. Put OS CD and choose CD-ROM driver = Next

Add Hew Hardware Wizard

Wwiindows will search for new drivers in itz driver databaze
on your hard drive, and in any of the following zelected
locations. Click Mest to start the zearch.

W CO-ROM diive

[ Microsoft Windows Update

[T Specity a location:
| wINDOWS ¥

Browse. . |
¢ Back I Meut > I Cancel |

4. Next

Add Mew Hardware Wizard

Windows driver file zearch for the device:

IJSB Human Interface Device

Windows iz now ready to install the best driver for this
device. Click Back to select a different driver, or click Mest
to caontinue.

Location of driver:

C:WINDOWSSINFAHIDDEY. INF
=

< Back

Cancel |

ARGOX
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5. Finish

Add Hew Hardware Wizard

ARGOX

% ISE Human Interface Device

YWindows has finished inztalling the software that your new
hardware device requires.

Cancel |

6. You can see “USB Human Interface Device”

System Properties

Gerneral Device Manager | Hardware Profilesl F‘erformancel

& View devices by lype

7 View devices by connection

= Disk drives

@ Dizplay adapters

2 Floppy dizk contrallers
vl Hard disk cantrollers

]--@ Fepboan
@ Monitors

ey Mouze

H- B Metwork adapters
]@ Other devices

- ¥ Ports [COM & LPT)
]--- System devices

e,

Froperties | Refresh

HHuman Interface Devices
Hg HID-compliant device
~-fidg USE Human Interface Devi

LR LSRR IOV I = PRSP |

|»

Cancel |

in System Properties.

ArgoLink (V1.00) 12



7.2 How to upload the program to PT-10
1.  Build the modified program in ArgoBuilder

A RGOX

H ArgoBuilder - ExSample g ] |
File Edit View &Zetop Tools He
O @H|E|""'A|£( |‘? ¥?|J|System12x3 j|,EE|
Page :
. Page—— File —
Sl 4 Display
7% G \f-_l Data
Input il
EIW”
Lookup
Menu w® |
_ E
H EH A B
Build R

2. ArgoBuilder will start compiling the program and create a new abp file.

ilder- ExSample _|EI|1|
Fil=: Edit Wiew Setup Tools Help
D@n|.@|'"“ﬂ|a|?¥?|J|System12x3 j|,EE|
Page MName
Page—— File —
Page 1
& | Digplay
Data
S |
Lookup
EENRENEENENE
LB |

For Help, pres Fl

o
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1Builder - ExSam
File Edil My Setip Tool Help

Areox

3. Save and overwrite the file (or save as another file).

~loix

0 #E| $ | A | ﬂ | ? *—’“lSystem 12x8

~]|[B &

Page HMName
Page——
Page 3

Digplay
x cv__|
Input

Menu

E

—File—

Al alowl

Save the active document l_ Wl—
4. Run ArgoLink
~lcixd
b @H|E|'"“A|E a@|? ¥?|J|System12x3 j|’EE|
\—g
Fage Nam :
; Page—— File —
fods. 4 Digplay
% a0 \._'-_l Data
Input il
8 1m |
Lookup
Menu W |
- E
H H B H
ArgoLink [ mwumM [
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5. ArgoLink dialog box appears and please click “Send” to load the program.

nk I ] 3 |
File Wiew Setip Tonl Help
28 W
Project:
=F
Add

= Prograrm
~Font:
~Lookup File:

- Data File:
Remaowve
About
8~ i| ar‘i| *« |
Status Send Recaive Sefup
Ready [= T

6. Set com port and connect to PC.

=10l x]
File: Wiew Setup Tool Help
| B &
= ~COptions Add
Fort:  taieEl
Baud Rate: m

Data Bits:

Barity: [joe -]

Stop Bits:

m‘ Offine |

Remaove

About

E

g i a~d & \
Stahus Send Receive Sehup
Ready ’_"“—7’— A
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7. File sending
ik P ] 5|
Fie View fetup Tool Help
= | - | -
Prc
BLLILII]] =
T =

Data Bits: IS vl R
2move

Barity: INDne 'I
Stop Bits: Il vI

Offline | Aboit
g 8- ‘5<|

Stahus Send

L]

Receive Setp

Passing C:Mrogrom Files\ARGOEM reoBuilder\Pro gram\ExSample abp Coml,115200,,8,1 A

8. Program loading completed.

ik i ]
File: View Setup Tool Help
= ‘ S

Project;

144
-

About |

g~ * f"i| "5<|
Status Send Receive Setp

Pagzsing C:\Program Files\d RGO \ArgoBuild extProgram\Examnple abp |E—:om1,1 15200,1,8,1 “
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7.3 How to check PT-10/12 firmware
Please press "FN" +"9" keys, then you can get firmware version.

7.4 How to update PT-10 with new firmware
1. Link RS232 cable between PT-10 and PC.

2. Power on PT-10 and run ArgoLink software

3. Set PT-10 to Upgrade Mode
® 4. Setting
® Enter “0000” as password
® 4. F/W Upgrade

4. Click “Upgrade New Firmware” button

= s
| File View Sm Tool Help
[=[8 k)
| project /e v Fmven]
I.__I:l :
Add
~Program:
~Font:
- Lookup File:
- Data File:
Removel
‘ About |
8~ i\ ,.1| « |
| Status Send Receive Setup
Firmevare download —Ti— [ 7
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Set Com port and click “Connect” button
HpArgolink =1=x]

File Wiew Setip Tool Help

T (] 444
= | -) | -

= ~Options Add
Part: e

Baud Rate: lm

Data Bits: m -
o lm amaove

Stop Bits: m

N

n Oftline About
a- i gt 4|

Status Send Receive Setp

L]

Eeadyr — 4

Click “OK” to confirm upgrade procedure

ik o i [ |
File View Setup Tool Help
2B -
Project:
=t P_rOJect: Add

~Program:
Font:

x|

Update New Firmware need format Disk C. Remove |
Aire you sure to vpgrade firmware.

About |

A~ i| ,.-:a| %< |
Status Send Receive Setup
Ready Coml, 115300,17,5,1 y
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7. Select firmware file in your PC and click “Start” button. The upgrade firmware

will start to proceed.

: N ] 5|
File ¥iew Zetop Tool Help
|8 &
Project;
=-Project: T
2]
BBUED [ ArgBuider =] & & cf E-
Data
i
Fonts j
Lookup
Program
Project
TERAHN): RO J
EFEEANT): [Kernel File (*bin) | B |
2
[Ver L] 5 e | bl r'-l = |
Status Send Receive Sehup
Ready Coml,115200,6,8,1 b
8. Click OK to start the upgrade procedures.
ik ] 53
Fil: Wiew &etop Tool Help
F- g PC
x|
ij Presz "OK" 1o Update Firmware
TWatch out your Terminal LCD.
Terminal will shut down while update Complete.
BT
Ready Coml,115200,1,8,1 %
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9. Firmware upgrade completed.

3 ]
' File View Setnp Tool Help
1 +i4
B -
=4 PC
ArgnLink
Ready [Coml1T5200,108,1 | Y

10. Press any key on PT-10 and press “Power” key to re-start PT-10.

7.5 How to check cradle (CRD-10) firmware version?
Please set the connection port first.

“Setup” > “Select Connect Port” - “USB” or “Serial port”

Then when you click
“Help” 2 “Cradle Version”, you will get the cradle firmware version

information on the dialog box.

Note: PDT must be put into cradle (CRD-10)
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7.6. How to upgrade cradle (CRD-10) firmware?

Note: Please make sure that the USB cable and power adapter are well installed

1. Go to Device Manager in Computer Management (local) and see the
property of Cradle DFU Mode?

LI Computer, Management r._]@|g|
Q File — Action  Wiew  MWindow  Help = & _]
e EEEFS 2 A <R
Computer Management (Local) - ARGOR-BO1FIYDMO ~
] ﬁ@ System Tools + i Camputer
+ - Event Viewer +| g Disk drives
¥ Shared Faolders + g Display adapters
+ Local Users and Groups + DVDJCD-ROM drives
+-#4] Performance Logs and Alerts +-i= Floppy disk controllers
=) Device Manager +- i, Floppy disk drives
= @ Starage + {88 Human Interface Devices
+ Remowvable Storage = IDE ATAJATAPL controllers

Disk Defragmenter
Disk Management
+- & Services and Applications

‘Z Kevboards
7% Mice and other pointing devices
& Manitors
B8 Network adapters
= @- Other devices
3 Cradle DFU Mode
P |3 '_? f1+ Multimedia Audio Contraller

- - [

b

2.  Click Reinstall Driver with the driver provided by ArgoLink.

Cradle DFU Mode Properties

General | Diiver

.\> Cradle DFU Mode

Device type: Other devices

Manutacturer: Unknown

Location: Cradle DFU Mode
Device status

| This device is not configured comectly. [Code 1)

| Ta reinstall the drivers for this device, click Reinstall Driver. ‘
|

Reinstall Driver...

Device usage:

! Use this device [enable] |

Ok ] [ Cancel
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3. Remove the plastic cover first, and switch no. 1 to “ON”. (Please see below

picture for reference)

4.  To execute ArgoLink
“Tool” - “Cradle F/W upgrade”

DFU  : [Cradle DFU Made =
Filename: ] Browse
(fp)ae L cancel

NS
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5. Go to Device Manager in Computer Management (local) and see the property

of “Cradle DFU Mode”.

fay ArgoLink 2.10

HE e SFE 15 HB
& B &
. [2]%]
= msuE0 (@A x| & BeF E-
ISE::peasd
3 FvEhs
iR LR
(_7)2P T30 Testing Tools
=) DFU_7265 dfu.
ﬁﬁﬁﬁ?\ [E5 =) |
FER ( [DFU Files (* dfn) - i
romeran ) = | )
| 5 (K|
(EEES BEH BRAE
Ready —i— /J

6 Press “start to upgrade”

G ArgoLink 2.10
H®E HE =E 1B N

B B &

LY R mREY

Ready

B FE
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6 Precede firmware upgrade

Ef ArgoLink 2.10

B B &

LY

DFU $58 ICradIe DFU Made oA,

BEEE: IDFU_?265.dfu

B | E
RAm

Ready ,_’“—7 ’— A

7 After completing the download job, turn off the power and adjust the dipswitch

no. 1 back to “OFF” position.

%@ ArgoLink 2.10

BF ME =T IH &9
& | B

1i
-~

LY meapEy
foA

| _Ja-| .E_,,_.&| 6(‘
B BiER FE

Ready ’_""—7 '— 7 |
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